
Intro to the World of IT1

> Qualities a technician should have

✓ 901-1.12 Install and configure 
common peripheral devices.

> Basic skills needed to function 
in the Windows environment 
and in the technical world

> Important computer parts

> Basic computer terms

✓ 902-5.1 Given a scenario, use 
appropriate safety procedures

✓ 902-5.4 Demonstrate proper 
communication techniques and 
professionalism.

In this chapter you will learn:

CompTIA Exam Objectives:
What CompTIA A+ exam objectives are covered in this chapter?
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Who Needs This Book?
More types of people than you would first think need this book. People who obviously need this 

information are those who will fix computers or work on a help desk or support desk. However, 

there are other types of users who might not be so obvious. Many folks who break into the informa-

tion technology (IT) world do so through jobs that require the A+ certification. Consider medical 

electronics technicians who repair common equipment used in hospitals. These technicians need 

this course because so many of their devices connect to a PC or have the PC-based software that 

controls the medical device. Further, the medical devices commonly attach to the wired and wire-

less network.

Another related field that must get A+ certified includes programmers. Programmers are 

expected to be able to install and remove software and hardware as part of their job. Similarly, 

database administrators might need to upgrade a server. Web developers might want to build their 

own machines. Look at Figure 1.1 to see the types of jobs of people who need the information in 

this book. It might also give you ideas about something you might like to do for a career.

FIGURE 1.1 IT roles

Technician Qualities
Each chapter includes a small bit of space on qualities a technician should possess or strive toward. 

Spending a little brain power on improving what many call your “soft skills” will pay off in pro-

motions and divergence into other IT-related fields. Three of the most important   qualities that a 

technician can have are active listening skills, a good attitude, and logic. Active listening means 

that you truly listen to what a person (especially one who is having a problem) is saying. Active 
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listening    skills involve good eye contact, nodding your head every now and then to show that you 

are following the conversation, taking notes on important details, and avoiding distractions such as 

incoming cell phone calls or text messages. Clarify customer statements by asking pertinent ques-

tions and avoid interrupting. Allow customers to complete their sentences. Many technicians jump 

into a problem the moment they hear the first symptom described by the user. Listen to the entire 

problem. Do not act superior because you know terms and things that they do not. Ask open-ended 

questions—questions that allow the user to expand on the answer rather than answer with a single 

word, such as yes or no. Figure 1.2 illustrates this point.

Closed-ended questions Open-ended questions

I saw where you logged a 
printer problem today, Bob. 
What do you want to bet the 
problem is the toner 
cartridge?

I saw where you logged a 
printer problem today, Bob. 
What happened?

So you are having email 
issues, Mrs. Jones. Do you 
have the conversations 
option enabled?

So what email issues are you 
having, Mrs. Jones?

Allow the users to state the problem without leading them toward a solution.
Restate the problem to ensure understanding and ask questions for clarity
and to narrow your understanding.

FIGURE 1.2 Asking technical questions

A positive attitude    is probably the best quality a technician can possess. Many technicians treat 

customers abruptly, not taking the time to listen to their problems or to find the best solutions. A 

good attitude is helpful when a user is upset because a computer or an attached device is not work-

ing properly. A technician with a positive attitude does not diminish the customer’s problem; every 

problem is equally important to the computer user. A positive attitude is critical for being success-

ful in the computer service industry. Figure 1.3   shows how negative attitudes affect your success.

Chances of Success Increase
with a Positive Attitude.

100%

0%

I see every issue as an opportunity to help or be positive.

I am sensitive to other cultures.

I don’t take the time to listen to the entire problem.

I blame others.

I think, "I can't, I won't, or I won't even try."

FIGURE 1.3 Have a positive attitude
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A technician must be familiar with and thoroughly understand computer terminology   to (1) use 

logic to solve problems; (2) speak intelligently to other technical support staff in clear, concise, and 

direct statements; (3) explain the problem to the user; and (4) be proficient in the field. Changes 

occur so frequently that technicians must constantly update their skills. Develop a passion for 

learning the latest information and searching for information that helps you solve problems. Do not 

develop tunnel vision in that you think the answer can be only one thing. Step back and look at the 

problem so that all possible issues can be evaluated. Be logical in your assessment and methods 

used to troubleshoot and repair. This book will help you with all of this by explaining computer 

terminology in easy-to-understand terms and providing analogies that can be used when  dealing 

with customers.

Before delving into computer topics, you should remember that a class can’t fully prepare you 

for every aspect of a job. You must learn things on your own and constantly strive to update your 

skills so you do not become obsolete. The IT field changes rapidly. Figure 1.4 illustrates this 

concept.

FIGURE 1.4 Preparing for IT job requirements

Finally, if you do break into   the IT profession as a computer technician or as a helpdesk support 

person, you will find that you must be a jack-of-all-trades, as shown in Figure 1.5.
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FIGURE 1.5 Computer technician skills

Breaking into IT with the CompTIA A+ Certification
Many information technology (IT)   jobs require the A+ certification. Even if not required, the 

certification shows that you have a good understanding of how computers work. This certification 

does not guarantee you a job, but it does open doors in that a company may interview you in the 

absence of IT experience.

A+ certification requires that you take two exams (220-901 and 220-902). You do not have to 

take both of the exams on the same day. You do not have to take the 220-901 exam before you 

take the 220-902 exam. Each exam covers specific material. Table 1.1 shows the major categories 

for the 220-901 exam and how they map to information in this book. Table 1.2 is for the 220-902 

exam.
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TABLE 1.1 CompTIA 220-901 A+ Certifi cation Topics

Domain Percentage of Examination Chapter(s)

1.0 Hardware 34% 1–10, 12

2.0 Networking 21% 13–14

3.0 Mobile devices 17% 11

4.0 Hardware and network troubleshooting 28% 1–14

TABLE 1.2 CompTIA 220-902 A+ Certifi cation Topics

Domain Percentage of Examination Chapter(s)

1.0 Windows operating systems 29% 15–16

2.0 Other operating systems & technologies 12% 17

3.0 Security 22% 18

4.0 Software troubleshooting 24% 15–18

5.0 Operational procedures 13% 19

“What are the exams like?” you might ask. The exams have multiple choice and performance-

based questions. Performance-based questions might be a drag-and-drop scenario or ask you to 

do something specific on a particular device or within a particular operating system environment. 

Each exam is 90 minutes long and contains a maximum of 90 questions. The testing system allows 

you to bookmark questions that you might want to return to at the end if you have time. Successful 

candidates will have the knowledge required to do the following:

> Assemble components based on customer requirements.

> Install, configure, and maintain devices, PCs, and software for end users.

> Understand the basics of networking and security/forensics.

> Properly and safely diagnose, resolve, and document common hardware and software issues.

> Apply troubleshooting skills.

> Provide appropriate customer support.

> Understand the basics of virtualization, desktop imaging, and deployment.

More information can be found on the CompTIA website (www.comptia.org).

At the beginning of each chapter, you will see a listing of which of the CompTIA A+ exam objec-

tives are covered in that chapter. At the end of each chapter, I’ve provided some A+ Certification 

Exam Tips—tips to definitely pay attention to if you plan on taking the A+ exam. By the end of 

this course, you will have learned all the topics covered on the certification exam; however, before 

you actually take the exam, I recommend that you dedicate some time to review the chapters in this 

book thoroughly, study the objectives, and take some practice exams. Pearson IT Certification, the 

publisher of this book, develops many different certification   exam prep resources that will suit your 

study style. See the back of this book for more information or go to http://pearsonitcertification.

com/aplus to browse the options.
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Basic Skills for This Course
In order to repair a computer, you need a   few basic skills that include being familiar with the 

keyboard and inputting information, searching for information on the Internet, and capturing 

information. Just because you may not be a good typist does not mean that you will not be good 

in an IT-related field.

Searching for Information on the Internet

IT people need to use all available resources including    online resources. As noted, you need to be 

capable of searching for information online. Figure 1.6 illustrates various online resources that IT 

people search all the time.

FIGURE 1.6 Search skills

Each chapter in the book has an activity at the end of it that enables you to practice searching 

the Internet for information relevant to the chapter. Tips for searching include the following:

> Search engines use different algorithms, so if one does not work, try another one. Examples 

of search engines are Google, Bing, Yahoo, AOL, Ask, and Lycos. To access a search engine, 

open a web browser and type one of the search engine names followed by “.com.” Figure 

1.7 shows www.Lycos.com entered in the address bar.

> Use descriptive key words.

> Do not include common words like the, in, at, or for because search engines tend to skip these 

words anyway. If you do want to use them, put a plus sign (+) in front of the word.

> Avoid using the plural or past tense of a word to avoid elimination of pages that are relevant. 

For example, to search for how to install a Bluetooth headset, avoid using the word installa-
tion, installed, or installing in the search window. Simply include the word “install.”
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> If there are several words used together (an exact phrase) such as Windows 10, put quotations 

around the phrase—“Windows 10”.

> Use as many distinguishing words as possible.

> If two words mean the same and are commonly used, use the word “or” in the search. For 

example, if you were searching for generic information on a dot matrix printer, which is 

sometimes called an impact printer, the search would be as follows: "dot matrix" or 
impact printer. Note that the vertical bar (|), which is the key above the E key, 

can be used instead of the word “or.”

> If a particular term can have two meanings such as the word memory relating to something 

inside a computer or else relating to a brain function, then you can use the minus sign in 

order to keep that information from being displayed. Memory –brain is an example of such a 

search.

> If a particular term such as memory is generic, you can add a word and use the word AND in 

order to clarify the search, such as computer AND memory.

> When searching for technical information, include the hardware or software manufacturer. 

A search for Microsoft Windows 10 provides different results than simply a search 

for Windows 10.

> If nothing relevant is on the first page of links, change the key words used in your search.

FIGURE 1.7 Lycos search engine

Take the situation of a keyboard    that intermittently works on a Microsoft Surface computer. The 

keyboard does not come standard as part of a Surface purchase. You do not own a Surface yourself 

and are unfamiliar with the tablet, but must support it. An example of what might be typed into a 

search engine is Microsoft Surface intermittent keyboard. A lab at the end of the 

chapter demonstrates search techniques.

Capturing Files

Sometimes, part of technical documentation     is being able to capture what is on the screen. 

Windows Vista (any version but Home Basic) and higher comes with a great tool for doing just 
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that. The Snipping Tool makes documenting problems easy. It is also easy to copy what you cap-

ture into other applications. No matter what IT job you may have when you enter the workforce, 

documentation is a part of all IT jobs. A lab at the end of the chapter shows how you might use 

this tool.

Creating a Text File

Another part of documentation      might involve creating or using a text file known as a .txt file. 

You might need to send it as an attachment or you might need to create a text file as part of the 

documentation process or as part of the job. Sometimes a text file is the easiest way to create 

a file, especially on a mobile device. Text files can be created using a word processor and the 

Save As process, or can be created using specific text software or an app. Text files are popular 

because they can be opened by so many applications or other mobile apps. Text files commonly 

include only text, but not multiple fonts or graphics. Windows ships with a basic application called 

Notepad that can be used to create or open text files. A lab at the end of the chapter helps with 

this skill.

Types of Computers
The simplest place to start to learn about computer technical support is with the devices them-

selves. Computer devices come in many shapes and sizes. The PC, or personal computer, comes

in desktop, tower, and all-in-one models, as well as mobile models such as a laptops, tablets, 

and ultrabooks. Figure 1.8 shows some of the computing devices technical staff are expected to 

support.

All-in-one Computer

Tower Computer

Laptop

Tablet Phone

FIGURE 1.8 Types of computers



10 Complete CompTIA A+ Guide to IT Hardware and Software

Basic Computer Parts
Computer systems include hardware, software, and firmware. Hardware is something  you can 

touch and feel—the physical computer and the parts inside the computer are examples of hard-

ware. The monitor, keyboard, and mouse are hardware components. Software interacts  with the 

hardware. Windows, Linux, OS X, Microsoft Office, Solitaire, Google Chrome, Adobe Acrobat 

Reader, and WordPerfect are examples of software.

Without software that directs the hardware to accomplish something, a computer is no more 

than a doorstop. Every computer needs an important piece of software called  an operating system, 

which coordinates the interaction between hardware and software applications. The operating sys-

tem also handles the interaction between a user and the computer. Examples of operating systems 

include Windows 7, 8, 8.1, and 10, OS X, and various Linux systems, such as Red Hat and Ubuntu.

A device driver is a special   piece of software designed to enable a hardware component. The 

device driver enables the operating system to recognize, control, and use the hardware compo-

nent. Device drivers are hardware and operating system specific. For example, a printer requires a 

specific device driver when connected to a computer loaded with Windows 7. The same printer will 

most likely require a different device driver when using Windows 8 or 10. Each piece of installed 

hardware requires a device driver for the operating system being used. Figure 1.9 shows how hard-

ware and software must work together.

User Software applications

Operating system

Kernel

Device 
drivers

Device 
drivers

Device 
drivers

Video BIOS

Hard drive Video card Keyboard

FIGURE 1.9 Hardware and software

Notice in Figure 1.9 the operating system kernel. The kernel is the central part of an operating 

system. The   kernel is the connection between hardware and the applications being used.
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Software applications are normally loaded onto the hard drive. When a user selects an applica-

tion, the operating system controls the loading of the application. The operating system also con-

trols any hardware devices (such as the mouse, keyboard, monitor through the video adapter, and 

printer) used with the application.

Firmware is a combination of    hardware and software such as when electronic chips contain 

software inside them. The chip is physical, which is hardware, and it has software built into the 

chip. An example of firmware is   the basic input/output system (BIOS) chip. The BIOS always has 

startup software inside it that must be present for a computer to operate. This startup software 

locates and loads the operating system. The BIOS also contains software instructions for com-

munication with input/output devices, as well as important hardware parameters that determine 

to some extent what hardware can be installed. For example, the system BIOS has the ability to 

allow other BIOS chips that are located on adapters (such as the video card) to load software that 

is loaded in the card’s BIOS.

A PC typically  consists of a case (chassis), a keyboard that allows users to provide input into 

the computer, a monitor that outputs or displays information, and a mouse that allows data input 

or is used to select menus and options. An input device is     used to put data into the computer. A 

microphone, keyboard, mouse, and your finger (when used with a touchscreen or touch-enabled 

device) are great examples. Also, biometric devices can be input devices. Common biometric 

devices are a finger swipe reader and an integrated camera that can be used for facial recognition 

to gain access to a device.

An output device such     as a display accepts data from the computer. A display is the monitor 

screen. Figure 1.10 shows a computer display that could be called a flat panel, monitor, display, 

or screen.

FIGURE 1.10 Computer display

Some devices can be both input and output devices, such as a smart TV, set-top box (the box 

used to connect a TV to a cable or satellite system), musical instrument digital interface- (MIDI) 

enabled devices (which are electronic musical devices), touch screen, or printer. In the case of a 

printer, data is sent from your computer to the printer, and the printer can send data (information), 

such as an out-of-ink message, back to the computer. Figure 1.11 contains common input and 

output devices.
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Input Devices Output Devices

Mouse, Keyboard, Digital Pen, Digital Tablet,
Finger, Signature, Pad, Touch Screen, Track Pad,
Touch Pad, Trackball, Track Stick, Stylus, Barcode
Reader, Digitizer, Game Pad/Console, Joystick,
Scanner, Camera

Printer, Speakers, Display Devices

FIGURE 1.11 Input and output devices

A device that can be both an input device and an output device is a KVM switch. KVM stands

for keyboard, video, mouse. A KVM switch allows connectivity of multiple devices so they can 

be shared between computers. For example, one keyboard, one mouse, and one display could con-

nect to a KVM switch. A KVM switch has cables that allow it to connect or output to two or more 

computers. Figure 1.12 shows the back side of a KVM switch.

FIGURE 1.12 KVM switch

Once the computer cover or side is opened or removed, the parts inside can be identified. The 

easiest part    to identify is the power supply, which is the metal box normally located in a back 

corner of the case. A power cord connects the power supply to a wall outlet or surge strip. One 

purpose of the power supply is to convert the outlet AC voltage to DC voltage used in the PC. The 

power supply distributes this DC voltage using power cables that connect to the various internal 

computer parts. A fan located inside the power supply keeps the computer cool, which avoids dam-

age to the components.
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A personal computer usually has a device to store software applications and files. Two examples 

of storage devices       are the hard drive and optical drive. The hard drive, sometimes       called hard disk, 

is a rectangular box normally inside the computer’s case that is sealed to keep out dust and dirt. 

An optical drive holds discs (compact discs, or CDs), digital versatile discs (DVDs), or Blu-ray 

discs (BDs) that have data, music, video, or software applications on them. Figure 1.13 shows the 

major components of a tower computer. Figure 1.14 shows a hard drive as it would look before 

you install it. Figure 1.15 shows an optical drive. Figure 1.16 shows a power supply. Figure 1.17 

shows a tower computer case.

Flat screen monitor

Mouse

Keyboard

Case

Power supply

CD/DVD drive

Hard drive

Motherboard

FIGURE 1.13 Tower computer

FIGURE 1.14 Hard drive

FIGURE 1.15 Optical drive
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FIGURE 1.16 Power supply

FIGURE 1.17 Tower case

The motherboard is the main    circuit board located inside a PC and contains the most electron-

ics. It is normally located on the bottom of a desktop or laptop computer and mounted on the side 

of a tower computer. Other names for the motherboard include       mainboard, planar, or system board. 

The motherboard is the largest electronic circuit board in the computer. The keyboard and mouse 

frequently connect directly to the back of the motherboard. Figure 1.18 shows a motherboard when 

it is not installed inside a computer.

The motherboard holds memory modules. Memory is an important part     of any computing 

device. Memory modules hold applications, part of the operating system, and user documents. 

Random access memory (RAM)    is the most common type of memory and is volatile—that is, the 

data inside the module is lost when power is removed. When a user types a document in a word 

processing program, both the word processing application and the document are in RAM. If the 

user turns the computer off without saving the document to removable media or the hard drive, the 

document is lost because the information does not stay in RAM. (Note that some applications have 

the ability to periodically save a document, but this is not a guarantee that it has the latest informa-

tion.) Figure 1.19 shows some memory modules when they are not installed into the motherboard 

memory slots. Look back to Figure 1.18 to see the memory modules installed in the motherboard. 

Memory is covered in great detail in Chapter 7.
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FIGURE 1.18 Computer motherboard

FIGURE 1.19 Memory modules

A device may have a cable that connects the device to the motherboard. Other devices require 

an adapter. Adapters are     electronic circuit cards that normally plug   into an expansion slot on the 

motherboard. Other names for an adapter are controller, card, controller card, circuit card, circuit 

board, and adapter board. Adapters allow someone to add a functionality that is not provided 

through the ports on the motherboard. An example is someone who wants better sound or video 

graphics, or additional ports of some type in order to connect external devices. Figure 1.20 shows 

an adapter. Notice how the contacts at the bottom are a particular shape. Chapter 3 goes into more 

detail about the types of expansion slots and adapters. You can also look back to Figure 1.18 to see 

a video adapter installed into a motherboard expansion slot.
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TECH TIP

FIGURE 1.20 Adapter

How to identify an adapter’s function

Tracing the cable(s) attached to an adapter or looking at a device connected to an adapter can 
usually help with identifying an adapter’s function. For example, typically a monitor has a cable 
going between it and a video adapter or motherboard.

The following are the generic steps for installing adapters:

 Step 1. Always follow the manufacturer’s installation directions. Use an antistatic wrist strap 

when handling adapters. Electrostatic discharge (ESD) can damage electronic parts. 

(See Chapter 5 for more details on ESD.)

Step 2. Be sure the computer is powered off and unplugged.

Step 3. Remove any brackets from the case or plastic covers from the rear of the computer that 

may prevent adapter installation. Install the adapter in a free expansion slot and reat-

tach any securing hardware.

Step 4. Attach any internal device cables that connect to the adapter, as well as any cables that 

go to an external port on the adapter, if necessary.

Step 5. Attach any internal or external devices to the opposite ends of the cable, if necessary.

Step 6. Power on any external devices connected to the adapter, if applicable.

Step 7. Reattach the computer power cord and power on the computer.

Step 8. Load any application software or device drivers needed for the devices attached to the 

adapter.

Step 9. Test the device(s) connected to the adapter.
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See Figure 1.21 for an illustration of a motherboard, expansion slots, memory, and     an adapter 

in an expansion slot.

Motherboard

Memory
Adapter

Expansion slots

FIGURE 1.21 Motherboard with expansion slots and an adapter

Mice and Keyboards
Input devices, such as the mouse and keyboard, attach to the motherboard. The most common 

type of mouse is an optical mouse, which has optical sensors    that detect the direction in which 

the mouse moves. It uses reflections from light-emitting diodes (LED) from almost any surface 

to detect the mouse location. Mice commonly can be adjusted for sensitivity—how far you have 

to move the mouse for how far it moves on the screen. Mice are rated in dots per inch (DPI). The 

higher the number, the more sensitive the mouse is. Mouse sensitivity can range from 500 to 3500 

DPI. Figure 1.22 shows a photo of the bottom of an optical mouse.

FIGURE 1.22 Optical mouse
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Keyboards are input devices     that connect to a port on the motherboard or attach wirelessly. 

Features users look for in a keyboard include a separate numeric keypad for those that have to input 

a great deal of numbers, adjustable tilt legs, and spill-resistance. Figure 1.23 shows a keyboard and 

mouse that are commonly used with a tower, desktop, or all-in-one computer.

FIGURE 1.23 Keyboard and mouse

Mouse and Keyboard Preventive Maintenance

Mouse cleaning kits      are available in computer stores, but normal household supplies also work. 

Use the following procedures to clean an optical mouse:

> Wipe the bottom with a damp, lint-free cloth.

> Use compressed air to clean the optical sensors.

Keyboards also need periodic cleaning. Figure 1.24 shows keyboard-cleaning      techniques.

1. Turn keyboard upside down
 and gently shake out debris

2. Clean the keyboard (several options shown)

Wipes Brush

Compressed airVacuum

FIGURE 1.24 Keyboard cleaning techniques

Keyboard/Mouse Troubleshooting

One of the easiest ways to       determine whether a keyboard is working is to press the l 

or n key and watch to see if the keyboard light illuminates. Sometimes an application 

setting may be causing what appears to be a keyboard problem. Use another application to see if 

the keyboard is the problem. Keyboards can have LED lights that indicate a particular function. 

Table 1.3 contains the most common ones. Note that different vendors can label the lights in vari-

ous ways.
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TABLE 1.3 Common keyboard lights

Associated 
toggle key

Keyboard light Description

n Number lock (NUM 
LOCK)

Toggles the 10-key pad between digits 0 through 9 
and various functions such as HOME, PG UP, PG 
DOWN, END, and various arrow keys.

l Capital letters lock 
(CAPS LOCK)

Toggles between all uppercase and lowercase 
letters.

m Scroll lock A rarely used key used to prevent scrolling and 
use the arrow keys to progress through information 
displayed.

One key doesn’t work

If a particular key is not working properly, remove the key cap. The chip-removal tool included 
with a PC tool kit is great for this. A tweaker (small, flat-tipped) screwdriver also does a good job. 
After removing the key cap, use compressed air around the sticky or malfunctioning key.

If coffee or another liquid spills into the keyboard, all is not lost. Many people have cleaned 

their PC keyboard by disconnecting it and soaking it in a bathtub or a flat pan of water. Distilled or 

boiled water cooled to room temperature works best. Afterward, the keyboard can be disassembled 

and/or scrubbed with lint-free swabs or cloths. PC keyboards and mice are normally considered 

throw-away technology. The customer’s cost to pay a technician to keep cleaning a keyboard over 

and over again would pay for a new keyboard. Keep this in mind when troubleshooting such inex-

pensive devices.

1s and 0s
Computers are digital devices. That means they    understand 1s and 0s. One 1 or one 0 is known as 

a bit. In actuality, a “1” is simply a voltage level to the computer. So, when we type characters into 

a word processing application, for example, those letters get translated by the keyboard into volt-

age levels. Figure 1.25 shows this concept. Notice that each letter is represented by a combination 

of eight 1s and 0s. Each 1 will be a voltage level sent to the motherboard (and components on it). 

Each 0 is simply the absence of a voltage level.

What a
computer

sees

What we
see

FIGURE 1.25 Binary bits

Technicians need to be able to describe capacities such as hard drive capacities or available drive 

space. Eight bits grouped together are a byte. See Figure 1.26 to see how the hot dog is divided 

into eight sections (eight sections make a big old “byte”).



20 Complete CompTIA A+ Guide to IT Hardware and Software

FIGURE 1.26 A byte

Approximately 1,000 bytes is a kilobyte (kB) as seen in Figure 1.27. 1kB is 1,024 bytes to 

be exact, but industry folks simply round off the number to the nearest thousand     for ease of 

calculation.

Approximately 1 million bytes is a megabyte (MB)  , but a true megabyte is 1,048,576 bytes. 

540 megabytes is shown as 540MB, or 540M. Notice in Figure 1.28 how a megabyte is a lot more 

storage of 1s and 0s than a kilobyte.
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FIGURE 1.27 A kilobyte

FIGURE 1.28 A megabyte

Approximately 1 billion bytes (1,073,741,824 bytes) is a gigabyte (GB)   and is shown as 1GB 

or 1G. Approximately 1 trillion bytes (1,099,511,627,776 bytes) is a terabyte  shown as 1TB or 1T. 

Figures 1.29 and 1.30 show how storage capacities get larger.
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FIGURE 1.29 A gigabyte

FIGURE 1.30 A terabyte

When information     needs to be expressed exactly, binary prefixes are used. For example, when 

describing a value of 210 (1,024), instead of saying that it is 1 kilobyte, which people tend to think 

of as approximately 1,000 bytes, the term kibibyte (KiB) is used. When describing a value of 220, 

or 1,048,576, the term mebibyte (MiB) is used. Table 1.4 shows the terms used with computer 

storage capacity and binary prefixes when exact measurements are needed.

TABLE 1.4 Storage terms and binary prefi xes

Term Abbreviation Description

Kilobyte/kibibyte kB/KiB ~1 thousand bytes/210 bytes

Megabyte/mebibyte MB/MiB ~1 million bytes/220 bytes

Gigabyte/gibibyte GB/GiB ~1 billion bytes/230 bytes

Terabyte/tebibyte  TB/TiB ~1 trillion bytes/240 bytes

Petabyte/pibibyte  PB/PiB ~1,000 trillion bytes/250 bytes

Exabyte/exbibyte  EB/EiB ~1 quintillion bytes/260 bytes
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Term Abbreviation Description

Zetabyte/zebibyte  ZB/ZiB ~1,000 exabytes/270 bytes

Yottabyte/yobibyte  YB/YiB ~1 million exabytes/280 bytes

Frequencies are also important measurements in computers because everybody wants to know 

how fast their computer, processor, memory, and other parts are operating. Frequencies are shown 

in similar measurements, but instead of bits (b) or bytes (B), speeds are shown in Hertz (Hz). A 

hertz is a measurement of cycles per second. Something that operates at approximately one million 

cycles per second is known as 1 megahertz (1 MHz). For one billion cycles per second, 1 gigahertz 

or 1 GHz is seen. Transfer speeds are commonly shown in bits per second such as gigabits per 

second or Gb/s or bytes per second such as in megabytes per second or MB/s. Notice the capital 

letter B when bytes are used compared to the lowercase b when bits are used. These measurements 

are used in a lot of IT-related hardware and software.

Safety Notes
As a parting note into your journey into computer hardware and software, let’s take a moment to 

just mention safety. Safety is covered in each chapter, especially in Chapter 5, but no book on com-

puter repair can begin without stating that both the technician and the computer can be harmed by 

poor safety habits. Before beginning any PC service, remove jewelry. To protect yourself and the 

computer, make sure to power off the computer   and remove the power cord when disassembling, 

installing, or removing hardware, or doing preventive maintenance (cleaning).

Some things should be left alone

Never take an older CRT monitor or power supply apart unless you have been specifically trained 
on these components.

Technicians can also be harmed in doing menial tasks such as lifting a computer or heavy laser 

printer. Lifting is a common    requirement listed in IT job advertisements or explained during inter-

views. Technical jobs frequently specify a maximum lifting requirement of 40 to 50 pounds. Use 

proper safety precautions, such as those shown in Figure 1.31. The type of equipment you need 

and things that you can do to prevent harm to the computer are covered more explicitly in Chapter 

5, on power and disassembly.

Remove jewelry
before working
inside of a computer

• Bend at the knees
• Use your legs to lift
• Use lifting aids when possible
• Ask for assistance when possible

FIGURE 1.31 Safety tips
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Chapter Summary

> Many IT roles require detailed knowledge of PC hardware and software.

> Computer technicians should actively listen, have a positive attitude, and use logic when solv-

ing problems.

> The CompTIA A+ certification requires two exams: 220-901 and 220-902. Many people 

break into the IT field with this certification.

> IT staff must be proficient at searching for information on the Internet, capturing files, and 

documenting technical information.

> Computers consist of hardware (the physical parts), software (the operating system and ap-

plications), and firmware (hardware that contains software).

> Identify important computer parts installed in a computer and as standalone parts: case, key-

board, mouse, motherboard, monitor, power supply, hard drive, optical drive, adapter, riser 

board, and memory.

> Input devices provide data into the computer. The computer sends data to output devices. 

Some devices can be both an input and an output device.

> Mice, keyboards, and touch screens are important input devices. Mice and keyboards can be 

wired or wireless.

> Safety is important when working on a computer. Power it down and remove the power cord 

before working inside it.

> Use proper lifting techniques when servicing equipment.

✓ Get a good night’s rest the night before the exam.

✓ Ensure that you are knowledgeable and proficient with all of the terms and technologies 
listed in the official CompTIA A+ exam objectives.

✓ Ensure that you can identify the basic parts of the computer and explain the purpose of 
each one. Ensure that you know the following parts: hard drive, optical drive, power supply, 
motherboard, and RAM.

✓ The following communication and professionalism skills are part of the 220-902 exam: (1) 
use proper language; (2) maintain a positive attitude/project confidence; (3) actively listen 
(take notes) and do not interrupt the customer; (4) be culturally sensitive.

A+ 
CERTIFICATION 
EXAM TIPS

Key Terms
adapter .................................X

BIOS ...................................X

bit ........................................X

byte ......................................X

device driver ........................X

display .................................X

expansion slot ......................X

firmware ..............................X

gigabyte ...............................X

hard drive ............................X

hardware ..............................X

keyboard ..............................X

kilobyte ...............................X

KVM switch ........................X

megabyte .............................X

memory ...............................X

motherboard ........................X

operating system .................X

optical drive .........................X

optical mouse ......................X

output device .......................X

PC ........................................X

power supply .......................X

RAM ...................................X

software ...............................X

terabyte ................................X
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Review Questions

1. Match the part to the description.

____ motherboard a. Converts AC to DC

____ RAM b. Holds the most data

____ optical drive c. Has the most electronics

____ hard drive d. Fits in an expansion slot

____ adapter e. Contents disappear when power is off

____ power supply f. Holds a disc

2. Which career choice(s) would probably not need the information in this book? (Select all that apply.) 

[ PC repair technician | database administrator | programmer | helpdesk support | office manager | 

network cable installer | PC power supply reseller ]

3. Which of the following are important suggested Internet search tips? (Choose two.)

 A. Try another search engine when the first one does not provide satisfactory results.

 B. Use as many common words as possible like the, in, at, or for.

 C. Put quotations around two or more words that might be found consecutively in output.

 D. Use as few words as possible.

 E. Avoid using the name of the equipment manufacturer.  

4. Which type of memory is commonly found on a motherboard?  

5. When lifting a heavy computer, you should squat, bend at the knees, and use your legs to lift. [ T | F ]

6. How many tests must a person take in order to be A+ certified? [ 0 | 1 | 2 | 3 | 4 ]

7.  Is the following question open-ended or closed-ended? You say your computer has been running slow 

since Monday. Which applications have you installed this week? 

[ open-ended | closed-ended ]

8. List one example of having a positive attitude.  ___________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

9. Which of the following devices are commonly output devices? Select all that apply. 

[ digital piano | speakers | display | stylus | track stick | barcode reader | printer ]

10. People who work with computers might be expected to lift up to how many pounds?  ____________

11. Which Microsoft Windows application could be used to create a text file? 

[ Textpad | Notepad | WriteIt | NoteIt ]

12. Which Windows tool can be used to capture the screen? 

[ Notepad | Bluetooth | Internet Explorer | Snipping Tool ]

13. Rewrite the following conversation into an open-ended question.

  Technician: Good morning. I have a service log that states you are getting an error message whenever 

you access a PDF file. Have you done your Acrobat updates lately? 

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________
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14. List one procedure you would do to help an erratic optical mouse. 

 _________________________________________________________________________________

15. Match the capacity to the description.

____ bit a. 8 bits

____ kilobyte b. a 1 or a 0

____ megabyte c. approximately 1,000 bytes

____ byte d. approximately 1 million bytes

____ gigabyte e. approximately 1 trillion bytes

____ terabyte f. approximately 1 billion bytes

Exercises

Exercise 1.1 Identifying Tower Computer Parts

Objective:  To identify various computer parts correctly

Procedure: Identify each computer part in Figure 1.32.

1. __________________

2. _____________

3. _____________

4. _____________5. __________6. __________

7. __________

8. __________

9. __________

FIGURE 1.32 Tower computer parts identification

1.  

 2. 

 3. 

 4. 

 5. 

 6. 

 7. 

 8. 

 9. 
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Exercise 1.2 Identifying Computer Parts

Objective:  To identify various computer parts correctly

Procedure: Identify each computer part in Figure 1.33.

1

5

9

2

6

3

7

4

8

10

FIGURE 1.33 Computer parts identification

 1.   

 2.  

 3.  

 4.  

 5.  

 6.  

 7.  

 8.  

 9.  

10.  
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Activities

Internet Discovery

Objective:  To obtain specific information from the Internet regarding a computer or its associated 

parts

Parts: Computer with Internet access

Procedure: Using the Internet, locate technical information about a computer. Answer the following 

questions based on the retrieved information. Note that you may need to open more than 

one document in order to answer the questions.

Questions:

1. What is the name of the computer for which you found technical information?  

2. How much RAM comes with the computer?  

3. Which URL did you use to find this information?  

4. Which search term(s) would you use for the following scenario? An HP Windows 7 computer has a 

Samsung ML-2160 laser printer attached. This printer supports both wired and wireless printing. The 

computer that is wired to the printer can print just fine, but no wireless devices in the house can ac-

cess or even see the printer.

 _________________________________________________________________________________

 _________________________________________________________________________________

5. Which search term(s) would you use in a search engine to help a friend who has accidently deleted a 

file on a Windows 7 computer?   

  _________________________________________________________________________________

6. Which search terms would you use to find a video that shows you how to add an application to a 

Windows 8.1 desktop?  

 _________________________________________________________________________________

Soft Skills

Objective:  To enhance and fi ne-tune a future technician’s ability to listen, communicate in both writ-

ten and oral forms, and support people who use computers in a professional manner

Procedure:

1. In a team environment, list three qualities that are important in a computer technician. Create sce-

narios that demonstrate these qualities. Share these findings in a clear and concise way with the class.

2. In a team environment, list three qualities that are not good practices for computer technicians. Create 

scenarios that demonstrate these qualities. Share these findings in a clear and concise way with the 

class.

Critical Thinking Skills

Objective:  To analyze and evaluate information as well as apply learned information to new or differ-

ent situations

Procedure:

1. Find an advertisement for a computer in a local computer flyer, in a newspaper, in a magazine, in a 

book, or on the Internet. List which components you know in one column and the components you do 

not know in the other column. Select one component you do not know and research that component. 

On a separate piece of paper, write a description of the component based on your research, and then 

share it with at least one other person. Write the name of the person with whom you shared.

CLASSROOM

Flip
the

CLASSROOM

Flip
the

CLASSROOM

Flip
the
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2. Why do you think that many computer components are considered “throw-away” technology? List 

your reasoning. In groups of three or four, share your thoughts. Nominate a spokesperson to share your 

group reaction in two sentences or less.

3. One device touts a transfer speed of 100Mb/s, whereas another device advertises 50MB/s. Compare the 

two devices’ transfer speeds and indicate which one is faster. Locate a component you have or would like 

to have. Compare products paying particular attention to the transfer speed. Document your findings.

Labs
Lab 1.1 Getting Started in Windows 7

Objective:  To be able to use Windows 7 to locate and launch applications.

Parts: Windows 7 computer

Procedure: Complete the following procedure and answer the accompanying questions.

1. Power on the computer and log in. You may need to contact an instructor or student assistant for the 

userid and password.

2. Click the Start button in the bottom left corner of the screen. The Start button is used to launch appli-

cations and utilities, search for files and other computers, obtain help, and add/remove hardware and 

software. The Start button menu is configurable, as shown in a later lab. Figure 1.34 shows a sample 

Windows 7 Start button menu.

Start button

FIGURE 1.34 Windows 7 Start button

3. The left panel of the Start button window contains a list of commonly used applications. Items that have 

arrows to the right of the name have a submenu that contains recently used application files that can be 

accessed by holding the pointer over the right arrow and clicking on the file name in the right panel. A re-

cently used file does not have to be used. You can simply click the name of the application and it will open.

 List one application found in the left panel of the Start button menu.

  _________________________________________________________________________________
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4. There are several other ways to access applications from the Start button menu especially if it is not 

shown in the left panel. Explore one way by clicking on the All programs link at the bottom. The 

All Programs Start button option contains applications and folders that contain other applications. 

Notice the scrollbar on the right (see Figure 1.35) that enables you to scroll through the installed 

applications.

FIGURE 1.35 Windows 7 All Programs menu

 What is the name of the last All Programs application or folder shown on your computer?

  _________________________________________________________________________________

5. Examine the available applications located throughout the list.

 Which application do you think you might use the most?

  _________________________________________________________________________________

6. To access an application within a folder, you must first click on the folder, then click on the applica-

tion. Locate and select the Accessories folder.

 List three applications found in the Accessories folder.

  _________________________________________________________________________________

  _________________________________________________________________________________

7. Another way of accessing applications is through the Search programs and files textbox accessed 

from the Start button. Click on the Start button. Right above the Start button is this textbox. Click 

once inside the textbox and start typing the word note. Notice how at the top of the screen a couple 

of programs that have the word “note” in them appear.

 List one application found using the keyword “note.”

  _________________________________________________________________________________
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8. Click on the Notepad application at the top of the list. The Notepad application opens.

9. Notice the three buttons in the top right corner. These three buttons are common in a window and 

shown in Figure 1.36. Table 1.5 details the purpose of these buttons.

Maximize/
Restore down

Minimize
Close

FIGURE 1.36 Windows 7 window buttons

TABLE 1.5 Windows top right window buttons

Button Purpose

Minimize (straight line) Keeps the program running, but removes it from being 
active on the screen. Use the a + t buttons to re-
access the app. 

Maximize/Restore Down (rectangle) Used to make the window that holds the app full screen 
(maximize) or, if you size the window, restore it to its 
default size.

Close (X) Used to close an app.

10. Click on the far right close button to close Notepad.

11. Use the Search programs and files text box to locate and launch the Calculator application.

 Which three menu items are available with the Calculator application?

  _________________________________________________________________________________

12. Whenever you use an application, the open application icon appears on the Windows 7 taskbar at the 

bottom of the screen. The taskbar is customizable and this skill is taught later in the book. Notice 

how a small calculator icon appears on the taskbar. Click on an icon and that application appears on 

the desktop.

13. Minimize the Calculator application by clicking on the Minimize button (straight line) in the top right 

corner. Notice how the calculator is still loaded as indicated by the icon on the taskbar.

14. Use the All Programs Start button item to locate the Sticky Notes application accessory. Remember 

you must first access the Accessories folder to locate the applications within that folder. Notice how 

the Sticky Notes application icon is on the taskbar.
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15. An easy way to move between applications is by using the a + t keys. Hold down the a key. 

While keeping that key held down, tap once on the t key. A window with all open applications ap-

pears. While keeping the a key depressed and tapping the t key once, the cursor cycles through 

the open applications. When it highlights the application you want to re-access, let the a and t 

keys go. Use the a and t key to re-access the Calculator application.

Instructor initials: _____________

16. Close the Calculator application by using the Close button.

17. Click on the Sticky Notes application icon on the taskbar. Close the Sticky Notes application by using 

the Close button.

18. Easily access the Windows 7 Start button menu at any time by pressing the  key.

Lab 1.2 Getting Started in Windows 8

Objective:  To be able to use Windows 8 to locate and launch applications and locate control panels 

used in future labs.

Parts: Windows 8 computer

Procedure: Complete the following procedure and answer the accompanying questions.

1. Power on the computer. Windows 8 was designed for mobile (touch) devices so the Windows 8 desk-

top is different from previous Windows versions. However, some people bought computers and lap-

tops that did not have touch monitors. The method used to unlock a Windows desktop depends on the 

type of computer you have.

  • Touch screen—Press your finger on the screen and move upward.

  •  Desktop computer—Press any key and release, click the mouse anywhere, click the mouse near 

the bottom of the screen, or hold the mouse button down while moving the cursor upward.

  •  Laptop—Press any key and release, click the mouse anywhere, hold down the left track pad sec-

tion or button, or move the cursor upward.

2. Type the password. Contact the instructor or lab assistant if the password is unknown.

 Note: Anywhere in this lab when the direction is to “click” something, if a touch screen is available, 

you can tap with your finger instead.

3. The Windows Start screen appears. Figure 1.37 shows a sample Windows Start screen. You can press 

the Windows key ( ) at any time to bring up the Start screen. You can also point at the bottom left 

corner of the screen until a small Start screen display appears so you can click on it.
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Point here to access charms

Tiles

User

FIGURE 1.37 Windows 8 Start screen

4. The Start screen has the user listed in the upper right corner. This icon can lock the computer and 

sign out of the user account.

 What user account is being used to do this lab?

  _________________________________________________________________________________

5. The Start screen also contains tiles. Tiles are used to access apps, such as the current news, weather, 

or traditional applications such as a web browser or word processing software. Tiles are rectangular 

or square and fill the Start screen. Use the scrollbar at the bottom of the screen to access the tiles to 

the right.

 What is the name of the last app shown on the right?

  _________________________________________________________________________________

6. Examine the available tiles.

 Which app do you think you might use the most frequently?

  _________________________________________________________________________________

7. Parts of the Start screen that are not immediately evident are the charms. Charms are little icons that 

are used to quickly access apps. The charms that will appear depend on the manufacturer and are 

software-dependent. The charms seen from the Start screen commonly include charms to perform a 

search and access some common Windows settings. Figure 1.38 shows a sample of Windows 8 Start 

screen charms.
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FIGURE 1.38 Windows 8 Start screen charms

8. Access the Start screen charms by pointing to the bottom right corner of the screen. Click the Search 

charm. Figure 1.39 shows an example of the menu that appears.

FIGURE 1.39 Windows 8 Search Apps window

9. The options below the Search text window are selectable items to designate where you want to 

search. When learning to configure, maintain, and repair Windows, you will commonly use the de-

fault selection of Apps. In the Search textbox, type notepad and do not press E. Notice how 

the Notepad application appears to the left.

10. Click once on the Notepad app. The Notepad app opens.
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11. Notice the three buttons in the top right corner. These three buttons are common in a window. Look 

back to Figure 1.36 in Lab 1.1 to see them. Table 1.5 (also in Lab 1.1) details the purpose of these 

buttons.

12. Click on the far right Close button to close Notepad.

13. Sometimes the application you need is not one you remember. When you click on the Search charm, 

all apps display in the left panel and you can use the scrollbar at the bottom of the screen to search 

through them. Once found, click the app to open.

14. Access the Search charm. Do not type in the Search charm text box. Instead, access it by clicking 

one time in the panel to the left where all apps display. Locate the Sticky Notes app by scrolling 

through the apps. Open the Sticky Notes app.

 Which symbol is in the top left corner of the Sticky Notes app?

  _________________________________________________________________________________

15. Close the Sticky Notes app by using the Close button.

16. There are several ways to access the traditional Windows desktop. One way is to access the Desktop 

tile from the Start screen. Use one of the methods described to access the Desktop tile from the Start 

screen.

 What happened when you clicked or tapped the Desktop tile from the Start screen?

  _________________________________________________________________________________

Instructor initials: _____________

17. Re-access the Windows 8 Start screen by pressing the  key, clicking the Windows icon in the bot-

tom left corner, if available, or pointing the mouse to the bottom left corner of the screen and clicking 

on the small Start screen that appears.

Lab 1.3 Getting Started in Windows 10

Objective:  To be able to use Windows 10 to locate and launch applications and locate control panels 

used in future labs.

Parts: Windows 10 computer

Procedure: Complete the following procedure and answer the accompanying questions.

1. Power on the computer. The method used to unlock a Windows desktop depends on the type of com-

puter you have.

 •  Touchscreen—Press your finger on the screen and move upward.

 •   Desktop computer—Press any key and release, click the mouse anywhere, click the mouse near 

the bottom of the screen, or hold the mouse button down while moving the cursor upward.

 •    Laptop—Press any key and release, click the mouse anywhere, hold down the left track pad sec-

tion or button, or move the cursor upward.

2. Type the password. Contact the instructor or lab assistant if the password is unknown.

 Note: Anywhere in this lab when the direction is to “click” something, if a touch screen is available, 

you can tap with your finger instead.
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3. Windows 10 was designed for both traditional desktop and mobile (touch) devices. The Windows 10 

desktop is different from previous Windows versions and it is a mixture of Windows 7 and Windows 

8, as shown in Figure 1.40. You can press the  key on the keyboard at any time to bring up the 

desktop.

Start button Search box Task view

FIGURE 1.40 Windows 10 desktop

4. Notice the Start button in the right corner. Click on the Start button to access the tiled apps similar to 

the Windows 8 Start screen, as shown in Figure 1.41.

FIGURE 1.41 Windows 10 Start button
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5. Click the Windows icon again in the lower left corner to return to the desktop. The desktop has a new 

look to it along the bottom. The Start button is different. The text area to the immediate right of the 

Start button used to be in the Start button menu or part of charms in Windows 8. There is an area for 

the icons of the most commonly used applications. To the far right is the notification area.

 List one icon of a commonly used application that is on your desktop.

  _________________________________________________________________________________

6. Click the Start button. Locate and select the All apps option. Scroll through the options. Notice the 

list contains both applications and folders.

7. Locate and select the Windows Accessories folder to expand it. Locate and select the Notepad app to 

launch it.

 What is the name of the last menu item shown on the far right inside the Notepad app?

  _________________________________________________________________________________

8. Notice the three buttons in the top right corner in the Notepad window. These three buttons are com-

mon in a window. Look back to Figure 1.36 in Lab 1.1 to see them. Table 1.5 (also in Lab 1.1) details 

the purpose of these buttons. Use the Minimize button (straight line). Notice how the application icon 

displays at the bottom of the screen in the taskbar as a small blue spiral notebook.

9. Click on the Notepad application icon at the bottom of the screen. The Notepad application opens on 

the screen. Use the Close button (X) to close the application.

10. Another way to locate and launch an app is by using the Search the web and Windows textbox. Click 

once inside this textbox and type the word note, but do not press E. Notice that at the top of 

the screen the Notepad desktop app is listed. The Sticky Notes app also shows.

 List one other app that is shown that has the letters “note” in its name.

  _________________________________________________________________________________

  _________________________________________________________________________________

 Note: When you have two or more applications open in Windows 10, you can hold the a key down 

and press the t key to cycle through any open applications. Windows 10 has a Task View icon on 

the taskbar that serves the same purpose. Refer back to Figure 1.40 to see that useful icon.

11. Select and launch the Sticky Notes app. The Sticky Notes app opens.

 What symbol is in the top left corner of the Sticky Notes app?

  _________________________________________________________________________________

12. Close the Sticky Notes app.

13. Click on the Start button in the bottom left corner. Click in the tiled apps area. Launch one of the 

apps by clicking on a tile.

 Which app did you choose?

  _________________________________________________________________________________

Instructor initials: _____________

14. Close the application using the Close button.
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Lab 1.4 Using a Search Engine

Objective:  To use Google to effectively search for information

Parts: Windows 7, 8, or 10 computer with Internet access

Procedure: Complete the following procedure and answer the accompanying questions.

1. Power on the computer. Log in or unlock the screen.

2. Windows 7 users, click on the icon (Start button) in the bottom left corner, select All Programs, and 

then select a web browser.

 Windows 8.1 users—Access and launch a browser app such as Windows Explorer, Google Chrome, 

or Mozilla Firefox from the Windows start screen. If one is not readily visible, click on the Windows 

icon in the bottom left corner to get a customized view of the applications. (On a mobile device this 

may be a Windows symbol you touch on the front side of the device to access these apps. You can 

then click the  that is inside the circle in the bottom left to view All Apps and pick a browser app 

from there.)

  Windows 10 users—Access and launch a browser app such as Microsoft Edge, Microsoft Internet 

Explorer, Google Chrome, or Mozilla Firefox from the Windows start screen. If one is not readily 

visible, click All apps and scroll through the list to locate a browser app. Click on the browser app 

name to launch it.

3. In the browser window, type the following: www.google.com

 If a computer user has a Dell Windows 8.1 computer that the user complains is slow to boot, what 

search terms would you put in the browser window? List at least three.

  _________________________________________________________________________________

4. In the search text box, type the following: Windows 8 computer problems

 Approximately how many results list at the top of the screen under the menu?

  _________________________________________________________________________________

5. Change the search criteria to Windows 8 computer problem.

 Approximately how many results list at the top of the screen under the menu?

  _________________________________________________________________________________

6. Go into the first three problems by clicking on the first title line. To return to the search results, click 

the Back arrow (A).

 Do any of the problems have anything to do with slow booting?

  _________________________________________________________________________________

7. In the search text box, type the following: Windows 8.1 slow boot

 Access the first result by clicking on the title line.

 What was the resolution given in the resulting web link?

  _________________________________________________________________________________

8. Sometimes computer resolutions contain links to software that might not be free after so many days 

and may contain malware or a virus. Only click on a link or use software tools from trustworthy ven-

dors. Return to the search criteria by clicking on the Back arrow or retyping www.google.com in 

the search text box. Now change the search to the following: Microsoft Windows 8.1 slow 
boot and access the first result.

 Approximately how many results are available?

  _________________________________________________________________________________
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 Which resolution was given?

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

 Do you think that this might be a good solution for the person who owns the Dell computer? 

[ Yes | No | I have no idea ]

  _________________________________________________________________________________

9. Now add the word Dell into the search criteria. Make the search the following: Microsoft 
Windows 8.1 Dell slow boot

 Approximately how many results are available?

  _________________________________________________________________________________

10. Access the first result by clicking on the title line.

 What resolution was given?

  _________________________________________________________________________________

  _________________________________________________________________________________

  _________________________________________________________________________________

Lab 1.5 Screen Capture with Snipping Tool

Objective:  To use the Microsoft Windows Snipping Tool to effectively capture information

Parts: Windows 7, 8, or 10 computer with the Snipping Tool application

Procedure: Complete the following procedure and answer the accompanying questions. If you are not 

familiar with launching an application, complete Lab 1.1, 1.2, or 1.3 before doing this lab.

1. Power on the computer. Log in or unlock the screen.

2. Access a web browser. Leave it on the screen.

3. Many times when you are solving a problem, performing a task, or simply helping someone else, a 

picture is worth a thousand words. Locate and launch the Snipping Tool. The Snipping Tool applica-

tion starts as shown by a small window that opens (see Figure 1.42).

FIGURE 1.42 Snipping Tool application window

4. The Snipping Tool enables you to capture everything that shows on the screen (full-screen snip), a 

particular window that is open on the screen (window snip), a particular section of the screen that 

could be captured in a rectangle (rectangular snip), a particular part of the screen that is odd shaped, 

or when you simply want to capture an icon or symbol. Click the  beside the New menu option. 

The four options display. The default one has a  beside it.

5. Click on the Options menu item. One particular option that you can select by clicking inside a box is 

the Ink color and Show selection ink after snips are captured option. This option automatically creates 

a box around whatever information is captured. Do not select it yet. Click Cancel.

6. Ensure the browser window is not taking up the entire desktop area. You can use the Maximize/

Restore Down button located in the top right corner to size the window. Look at Figure 1.36 in Lab 

1.1 to see them. Table 1.5 (also in Lab 1.1) details the purpose of these buttons.
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7. In the Snipping Tool window, click the  beside the New menu option and select Full-screen Snip. 

The Snipping Tool application captures whatever is on the screen. If that is not what you want to cap-

ture and you only want to capture the search text box, click New and the Snipping Tool reverts to the 

small window.

8. Click on the  beside New again and select Window Snip. With a window snip, you must do an ad-

ditional step by clicking on the window that you want. Click anywhere in the browser window.

 What information is shown inside the Snipping Tool window?

  _________________________________________________________________________________

9. Pretend this still is not what you wanted because it is so big and you want to just capture the search 

text box. Click the Minimize button (the button to the left of the Maximize/Restore Down button you 

used before). The Minimize button is the icon in the top right that has a single line at the bottom of 

the icon. It is to the immediate left of the Maximize/Restore Down button.

10. Re-access the browser window by clicking anywhere on it. In the browser window, type www.
pearson.com in the text box at the top of the screen, but do not press the E key.

11. With the browser window open, re-access the Snipping Tool by clicking on the Snipping Tool icon 

located in the taskbar (scissors within a red circle icon) at the bottom of the screen. If the taskbar is 

not there, such as on a Window 8 computer, hold down the a key and while continuing to hold it 

down, press t. The currently running programs appear. Press the t key again until the Snipping 

tool is selected. Let go of both keys and the Snipping Tool application window appears on the screen. 

Ensure the Snipping Tool application window is on a part of the desktop by itself (not on top of the 

browser window). In order to move a window, you can click on the top part of the Snipping Tool win-

dow and while continuing to hold down the mouse or touchpad, drag the window to a different part of 

the screen.

12. Click the New menu option and select Rectangular Snip. The screen appears grayed out. This is nor-

mal. A crosshairs symbol (that looks like a plus symbol) appears on the screen. Move the screen cur-

sor (which, in turn, moves the crosshairs symbol) to the top part of the browser window that contains 

the search text box. Click and drag the crosshairs until it captures the part of the browser window that 

shows www.pearson.com.

 List one instance where you think an IT person might use the rectangular snip option.

  _________________________________________________________________________________

13. After taking a screen capture, the Snipping Tool window has more menu options available. Click the 

File menu option.

 Which four menu options are available?

  _________________________________________________________________________________

14. Click the Edit menu option. This option can be used to select Copy so you can simply paste into an 

email or word processing document. Select the Tools menu item. Point to the Pen option and select 

Blue Pen from the menu. Use the pen to circle the words pearson.com.

15. Access the Tools menu item again and select the Highlighter option. Highlight www.

Instructor initials: _____________

16. Close the Snipping Tool window by clicking on the Close button, which is located to the immediate 

right of the Maximize/Restore Down button. The Close button is in the top right of the Snipping Tool 

application window and has an X on the icon.

17. When asked if you want to save the snipped document, click No.
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Lab 1.6 Creating a Text File

Objective:  To use the various applications and apps to create a text fi le

Parts: Windows 7, 8, or 10 computer

Procedure: Complete the following procedure and answer the accompanying questions. If you are not 

familiar with launching an application, complete Lab 1.1, 1.2, or 1.3 before doing this lab.

1. Power on the computer. Log in or unlock the screen.

2. Locate and launch the Notepad application. The Notepad application starts, as shown in Figure 1.43.

FIGURE 1.43 Notepad application

 Which five menu options are available?

  _________________________________________________________________________________

 Which menu options do you think would be used to automatically insert the date and time?

  _________________________________________________________________________________

3. Notepad can be used to document problems on a computer that does not have word processing appli-

cations loaded or that has other issues. Both Microsoft Notepad and WordPad ship with the Windows 

operating system. Notepad does not have as many capabilities as WordPad. One of the things you can 

do with Notepad is insert the date and time into the document. Click the Edit menu item to see the 

full Edit menu, as shown in Figure 1.44.

FIGURE 1.44 Notepad Edit menu

4. Notice the words on the left and the corresponding keystrokes to the right. This means you can either 

use the mouse to access the Edit menu and then select Time/Date or you can simply press the 5 

key to do the same thing. Click away from the Edit menu so you can try the keyboard shortcut. Click 

inside the blank Notepad window. Now press the 5 key.
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5. Click the View > Status bar menu option.

 What did this option do?

  _________________________________________________________________________________

  _________________________________________________________________________________

6. Click the View > Status bar menu option again and notice how there is a checkmark now by the Sta-

tus bar option indicating that this option is enabled.

7. Notepad allows a few font modifications. To bold the date and time, click the Format > Font menu 

option to see the options as shown in Figure 1.45.

FIGURE 1.45 Notepad Font menu

 What is the default font (the font that is selected and highlighted by default)?

  _________________________________________________________________________________

 What are the names of the first and last font types? Use your mouse and the control bar to see the 

fonts.

  _________________________________________________________________________________

8. Click the Bold option in the Font style section. Click the OK button. You return to the Notepad win-

dow. Your date and time should have turned bold. Redo Steps 7 and 8 if the words are not darker 

(bolded).

 On your own, add the following message to the Notepad document. Ensure that you use the Verdana 

Regular 12 font type and size:

 Replaced display and tested. User confirms that the problem is 
solved.

9. Click the Help > View Help menu option.

 Which help topic would be of most interest to you?

  _________________________________________________________________________________

10. Close the Help window by clicking on the X in the upper right corner.
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11. A header is a part of a document that might not appear on the screen, but when the document is 

printed, the information inside the header prints at the top of the page. A footer is at the bottom of the 

document. To insert a header and a footer in Notepad, click on the File > Page Setup option. Note that 

when you change the information in the header and footer, that information stays there for the current 

Notepad document and future documents as well.

 Use Help to determine what the &f, the default setting for the header, and Page &p, the default set-

ting for the footer, mean. Document your findings.

  _________________________________________________________________________________

  _________________________________________________________________________________

12. Close the Help window.

____ Instructor’s Initials

13. To save the document, click the File > Save option. A window with several options appears, as shown 

in Figure 1.46.

FIGURE 1.46 Notepad Save menu

14. When saving a file, you want to give it an appropriate name. That is entered in the File name text 

box. Start typing documentation in the File name text box. Notice how it automatically replaces 

the highlighted *.txt name. Do not press E yet.

15. The current location is shown at the top of the screen. To change this location and save it onto your 

flash drive, for example, you must first select your flash drive from the left window. Note that drive 

letters change depending on the system. In Figure 1.46, the flash drive is G:. Click the Documents 

option in the left window. If any folders are on the drive, they appear. Click the Cancel button.

16. From the Notepad window, click the Close button (the button with a red X in the top right corner).

 What message appears?

  _________________________________________________________________________________

17. Click the Don’t Save button.
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